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Installation and Configuration

Installing the ICV Software

Please visit our website at www.metricstech.com to register your software, obtain your log-in
credentials and be issued a temporary or permanent codeword. This process is typically
completed within 24 hours or less.

The installation program for the Metrics ICV software installs all components necessary to
run Metrics ICV. You can download the auto-extracting archive MTICV-43.EXE from the
Metrics Technology website under Downloads link. Be sure to save the install file to your
local hard disk before running the installation. Running the installation from the website will
cause an installation error. You will need a valid customer login to enter the Software
Downloads area.

NOTE: You should also download the latest available HotFix release which can be found in
the same software list and designated MTICV-43-HFXX.EXE where the XX is the version
number of the HotFix. HotFixes contain resolutions to any reported issues and some
enhancements that have been added since the initial release of Metrics ICV 4.3. It is only
necessary to apply the latest HotFix to your system since all updates are contained in the
latest build. Save the HotFix file to your local computer and you will be can install it after
the base Metrics ICV installation is complete. It is recommended that you keep an archive
copy on CD of all HotFixes applied.

NOTE: Do not install the USB Security Key until after the Metrics ICV Software is
installed and the PC is restarted. The security key requires special drivers that are installed
with ICV.

Obtain a Codeword

Please visit our website at www.metricstech.com to register your software, obtain your log-in
credentials and be issued a temporary or permanent codeword. This process is typically
completed within 24 hours.



http://www.metricstech.com/
http://www.metricstech.com/

Important Note for upgrading Customers

The Metrics ICV setup program requires that you backup and uninstall the previous version.
To do this, please perform the following steps:

DO NOT LEAVE YOUR BACKUP ARCHIVE IN THE METRICS DIRECTORY! COPY
THE BACKUP.ZIP FILE TO A DIFFERENT LOCATION LIKE A USB DRIVE.

1. Go to the File Menu and select Backup

2. Enter the name of the backup ZIP archive in the default directory (i.e.
C:\METRICS\ICS\backup.zip)

3. Allow the backup utility to complete then copy the .ZIP file to another drive
location.

Metrics ICS files are now be stored in the windows file system. EXxisting tests should be
opened and then saved in the Metrics\ics\projects directory.
After upgrading, some of the functions of the software will require that older scripts or

features be modified. A complete list of deprecated features is contained in the Metrics ICV
Software Migration Guide.

Procedure to Upgrade ICV from 4.0, 4.1, 4.2 t0 4.3

1. Download the Metrics ICV installer MTICV-43.exe to the hard drive of your
compulter.

2. Select the MTICV-43.exe application icon to start the installation program.

NOTE: The installer may take up to 10 seconds or longer to uninstall the
previous version of the software before displaying the Welcome panel.



Welcome to Metrics ICV Setup

Advanced Installer

Welcome to the Wizard for Metrics ICV Setup.
Collecting information
Preparing installation
Installing lssbiit:p Wizard will install Metrics ICV on your computer. Please dick ™Next” to

Finalizing installation

3. Click Next button on the "Welcome" panel.

End-User License Agreement Advanced Installer

Collecting information Flease read the following license agreement carefully,

Metrics Technology Software Product
Preparing installation

. End User License Rgreement and Limited

Installing
Warranty

Finalizing installation .
IMECRTANT: Please carefully read the License
Lgreement below before clicking "I accept the
terms in the License Agreement” The right to
use this Metrics Technology scftware Product

@ I accept the terms in the License Agreement

@ Idonot pt the terms in the

4. Read the "Software License Agreement™ and click the I agree to the terms in the
License Agreement button to agree to the terms, if you agree. Then click Next.



# Metrics ICV Setup - X

Installation Folder Advanced Installer

This is the folder where Metrics ICV will be installed.

. Collecting information
o Preparing installation

Installiny

o < To install in this folder, dick "Next". To install to a different folder, enter it below or dick
"Browse",

o Finalizing installation

Folder:

v

5. Choose "destination location" for installation and click the Next button.

NOTE: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics ICV installation.

o Collecting information

. Preparing installation Click "Install” to begin the installation. If you want to review or change any of your

installation settings, dick "Back”. Click "Cancel” to exit the wizard.
o Installing

o Finalizing installation

6. Click the Install button to begin the Metrics ICV installation.

ICV Installation and Getting Started Guide



Welcome to the InstallShield Wizard for
Sentinel System Driver Installer 7.5.7

The Installshield(R) Wizard will install Sentinel System Driver
Installer 7.5.7 on your computer. Ta continue, dick Mext.

WARNIMG: This program is protected by copyright law and
international treaties,

Bac [ Mext= | [ Cancel ]

7. The Safenet Sentinel Pro driver installation will now be started to install the security
license components.

Program Maintenance

Modify, repair, or remove the program.

@ Modify

Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.

Repair installation errors in the program. This option fixes missing or
corrupt filles, shortouts, and registry entries.

Remove Sentinel System Driver Installer 7.5.7 from your computer,

Inztallshield

8. Select Modify setup type and click the Next button.



| 15 Sentinel System Driver Installer 7.5

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description
Sentinel System Drivers ) ) = )
. =3 = | USB System Dri The device driver for Sentinel
ystem Driver e

- (= = | Parallel Driver

This feature reguires OKE on
your hard drive. Ithas 0 of 2
subfeatures selected. The
subfeatures require OKB on your
hard drive.

C:¥Program Files (x86)\Common Files\SafeMet Sentinel\Sentinel System Driver),

Inztallshield

< Back ]I Mext = I [ Cancel

9. Select Custom setup type and click the Next button.

Ready to Modify the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

Install | [ Cancel

10. Click Install to start the Sentinel Driver installation.

ICV Installation and Getting Started Guide



i Sentinel System Driver Installer 7.5.7 - InstallShield Wizard |Z||E|rz|

Installing Sentinel System Driver Installer 7.5.7

The program Features vou selected are being installed,

Flease wait while the InstalShield Wizard installs Sentinel System Driver
Installer 7.5.7. This may take several minutes,

Status:

11. Allow the installation to complete.

i Sentinel System Driver Installer 7.5.7 - InstallShield YWizand E|

InstallShield Wizard Completed

The Installshield YWizard has successfully installed Sentine
Syskem Driver Installer 7.5.7, Click Finish to exit the wizard,

Finish

12. Then click Finish to continue with the Metrics ICS installation.



Installing Metrics ICV Advanced Installer

O Collecting information
o Preparing installation

. Installing

o Finalizing installation

13. Allow the Metrics ICV installation to complete.

A Metrics ICS Setup X

Metrics ICS Setup Complete Advanced Installer

Click the “Finish" button to exit the Setup Wizard.

o Collecting information
o Preparing installation
o Installing

. Finalizing installation

14. Then click Finish to complete the installation.
15. After the installation is finished, re-start the computer.

ICV Installation and Getting Started Guide 11



CB  You must restart your systemn for the configuration changes made to

I' | Metrics ICV to take effect. Click "Yes" to restart now or "No" if you plan

to manually restart |ater,

16. Connect the USB Security Key to the USB port of your computer. The Windows
Hardware Manager should detect the USB device as Safenet USB
SuperPro/UltraPro and should automatically install the driver for the device.

NOTE: It is recommended the security plug be connected directly to the computer
instead of through a USB hub or keyboard port if possible.



Procedure to Install ICV - New Installations

1. Insert the Metrics ICV install CD into the CD-ROM drive of your computer.

2. The CD-ROM should automatically start the MTICV-43.exe installation program.
If the installation does not start automatically then select right click on the CD drive
icon in Windows Explorer and then select "explore”. Select the MTICV-43
application icon to start the installation program manually.

The installation will check for any prerequisites and start the Prerequisites Wizard to
install the necessary software. Please note installation of these software components
requires acceptance of the 3" Party license agreements displayed during installation.
Installation of some components can take additional time so you should allow more
time for installation if these components are not already installed on your
workstation PC.

Welcome to the Prerequisites
Wizard

The setup has determined that some of the
prerequisites needed to run this program are
missing. This wizard will assist you in getting and
installing those prerequisites. Click Next to
continue to the list of prerequisites.

Click Finish at any time to completely skip the
installation of prerequisites and jump to the
installation of the main program. Click Cancel to
cancel the installation and exit the Setup Wizard.

3. Click Next button on the "Welcome™ panel.



Prerequisites

These programs are needed for the application to run. Click on the chedk box
next to a prerequisite to select it for install or to skip it.

Mame Version Action

NET Framework 4.0 Required: 4.0 or higher. Found: ... Instal
Visual C++ 2010 Redistributable 86 Required: any. Found: nothing. Install

Press the Next button to install the prerequisites.

05 Microsoft .NET Fea [

MET Frameworkxngtup _ N
Please accept the license terms to continue. ,ﬁmEmf

I:I

MICROSOFT SOFTWARE -

[¥]1 have read and accept the license terms. @

Download size estimate: oOME
Download time estimates: Dial-Jp: 0 minutes

Broadband: 0 minutes

[ Install ][ Cancel ]

5. Click I have read and accept the license terms then click the Install button on the
"Microsoft .NET Framework" panel.



"5 Microsoft .NET Frz

Installation Is Complete

FAY

Microsoft®

NET

.MET Framewaork 4 has been installed.

Check for more recent versions on i

6. Click Finish to continue.

" Microsoft Visual

Welcome to Microsoft Visual C++ 2010 x86 Redistributable Setup
Please, accept the license terms to continue. w

MICROSOFT SOFTWARE LICENSE TERMS i

MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES WITH
SERVICE PACK 1

These license terms are an agreement between Microsoft
Corporation (or based on where you live, one of its affiliates) and
you. Please read them. They apply to the software named above,

-

[#]1 have read and accept the license terms. @

[~ ¥es, send information about my setup experiences to Microsoft Corporation.

For more information, read the Data Collection Policy,

[ Install ] ’ Cancel l

7. Click I have read and accept the license terms then click the Install button on the
" Microsoft Visual C++ 2010 Redistributable " panel.



Installation Is Complete

Mmm Microsoft Visual C4++4 2010 x86 Redistributable has been
H * installed.
Visual Studio

ent versions of this package on
website,

8. Click Finish to continue.

Welcome to Metrics ICV Setup Advanced Installer

Welcome to the Wizard for Metrics ICV Setup.

Collecting information

Preparing installation

S i will i A -
Installing Isr?h;it:p Wizard will install Metrics ICV on your computer. Please dick Next” to

Finalizing installation

9. Click Next button on the "Welcome" panel.



End-User License Agreement

Collecting information
Preparing installation
Installing

Finalizing installation

Advanced Installer

Flease read the following license agreement carefully.

Metrics Technology Software Product

End User License Agreement and Limited
Warranty

IMPCRTANT: Please carefully read the License
Lgreement below before clicking "I accept the

terms in the License Agreement” The right to
use this Metrics Technology scoftware Produst

10. Read the "Software License Agreement” and click the | agree to the terms in the
License Agreement button to agree to the terms. Then click Next.

# Metrics ICV Setup

Installation Folder

Collecting information
Preparing installation
Installing

Finalizing installation

Advanced Installer

This is the folder where Metrics ICV will be installed.

To install in this folder, dick "Next”. To install to a different folder, enter it below or dick
"Browse”,

Folder:

11. Choose "destination location™" for installation and click the Next button.

ICV Installation and Getting Started Guide

17



Note: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics ICV installation.

o Collecting information

@ rreparing installation Click "Install” to begin the installation. If you want to review or change any of your

installation settings, dick "Back”. Click "Cancel” to exit the wizard.
. Installing

o Finalizing installation

12. Click the Install button to begin the Metrics ICV installation.

i Sentinel System Driver Installer 7.5.7 - InstallShield Wizard (X

Welcome to the InstallShield Wizard for
Sentinel System Driver Installer 7.5.7

The InstallShield(R) Wizard will install Sentinel System Driver
Installer 7.5.7 on your computer, To continue, dick Mext,

WARNING: This program is protected by copyright law and
international treaties.

[ Mexts | [ Cancel ]

13. The Safenet Sentinel Pro driver installation will now be started to install the security
license components.



License Agreement

Please read the following license agreement carefully,

License GrantWarranty for Software -~

Thiz License describes limited rights granted by SafeMet, Inc. andfor one of its
subsidiaries (such grantor, "Seller’) to the Buyer.

A.  Theterm "Software”, as used herein, shall mean a program or programs
cansisting of machine readahble logical instruction and tables of informatian
designed as libraries or drivers to work in conjunction with Seller's Sentinel
Keys ("Products”. Title to all Software furnished to Buyer hereunder shall

nnnnnnnn Dellmw T allae ;avmcd s 4m Dime o mmn ~owem

b

P TR P A N ey o £Y PN

(#)1 accept the terms in the license agresment

(7)1 do not accept the kerms in the license agreement

[ < Back “ Mext = ] [ Cancel ]

14. Read the "Software License Agreement” and click the | agree to the terms in the
License Agreement button to agree to the terms. Then click Next.

Setup Type
Choose the setup type that best suits vour needs.

Plzase select a setup type,

All program Features will be installed, (Requires the mosk disk,
space, )

(") Custom

Choose which program Features vou want installed and where they
will be installed. Recommended For advanced users,

[ < Back “ Mext = ] [ Cancel

15. Select Complete setup type and click the Next button.



Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation,

If vwou want to review or change any of wour installation settings, dick Back, Click Cancel to
exit the wizard,

[ < Back ]| Install | [ Cancel

16. Click Install to start the Sentinel Driver installation.

Installing Sentinel System Driver Installer 7.5.7

The program Features wou selecked are being installed,

Please wait while the Installshield wizard installs Sentinel Svstem Driver
Installer 7.5.7, This may take several minutes,

Skatus:

17. Allow the installation to complete.



i Sentinel System Driver Installer 7.5.7 - InstallShield Wizard E'

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Sentinel
Syskem Criver Installer 7.5.7. Click Finish bo exit the wizard.

= Back Einish Cancel

Then click Finish to continue with the Metrics ICS installation.

18. Allow the Metrics ICV installation to complete.

Installing Metrics ICV Advanced Installer

o Collecting information
o Preparing installation
. Installing

‘ Finalizing installation




A Metrics ICS Setup

Metrics ICS Setup Complete Advanced Installer

Click the "Finish" button to exit the Setup Wizard.

o Collecting information

o Preparing installation

o Installing

.‘ Finalizing installation

Then click Finish to complete the installation.

19. After the installation is finished, re-start the computer.

-"‘-I You must restart your systern for the configuration changes made to
L Metrics ICY to take effect. Click "Yes" to restart now or "No” if you plan

to manually restart later.

20. Connect the USB Security Key to the USB port of your computer. The Windows
Hardware Manager should detect the USB device as Safenet USB
SuperPro/UltraPro and should automatically install the driver for the device.

Note: It is recommended the security plug be connected directly to the computer
instead of through a USB hub or keyboard port if possible.



Metrics Codewords

Metrics Technology software products use a combination of a hardware Security Key and
Codeword. The unique combination of a Codeword and Security Key allows the software
product to be run on a any workstation PC.

Software Codeword Information

There will be a codeword for each software component ordered. This information is made
up of two (2) parts, the Registration Information and Codeword Information. We
encourage all customers to register their software with Metrics Technology. Only
registered users will receive technical support for their products.
Customer ID
The Customer ID is a number that has the form IAXXXXXA. Where the X is a
number. Variations include IHXXXXA, MHXXXXXA, and MKXXXXXA. This
number must match the number on the Security Key.
Product Desc

This is the Product Description. This will be the name of the product, such as
Metrics ICV or Metrics ICS.

Product ID
The product ID is MTICV or MTICS and should be entered in the ID field
Version
This is the version of the software i.e. 4.3.0
Note: The version number and the codeword are matched. Thus, customers who
have not purchased an upgrade will not be able to run it without purchasing the
correct codeword.
Codeword Serial (Example)

AYJE6-AKXMP-HXGCK-HMK4R-12HAB-U3AT6

Note: The software Codeword Serial number for ICS should be entered in each
application (ICV and ICS) separately.



Entry of the Codeword Serial Number

Development Probing Testing Analysis Tools Help  Exit

Device Algorithm Module Execute

Connect

Device

» fun

VEBScript |

Yy

Control

v ~
Backup Restore Config System ﬂETRl[E Plot Stats Analysis Help
KV g

W Cha et Systee

1. Start Metrics ICV to display the system window.

2. Open the System Configuration window by selecting Tools » System Configuration
or click the Config button.

3. Click on the "Software License Codewords" tab

Note: This tab will open automatically if no codewords have ever been entered. You
will receive a warning message to enter codewords the first time you start Metrics
ICV. Please follow the instructions below to enter your codewords.

Note: It is recommended that you cut and paste the codeword from the registration e-
mail or certificate sent from Metrics Technology Customer Service. Be careful not to
include any space before or after the code word string.

If typing the codeword from the keyboard be careful not to transpose letters or
numbers. The letter | can be confused for the number 1 and the letter O can be
mistaken for the number 0.



Software License Codewords

MTICV 400

Product 1D:

Version: fcacx)

Codeword:

4. Enter the Product ID, Version, and Codewords supplied on the product registration
certificate or e-mail.

Software License Codewords l

MTICV 400 AGRCE-6PXRN-03GAX-KOBV-3UXI11-MRAHH

I

Product ID: [MTICY

Version: fcxx) |4_D.D

Codeword: |AG RCE-6PXRN-03GAX-KOBV-3UXI1-MRAHH

5. Enter the ICV codeword information. Click the Set button.



Software License Codewords |

MTICV 4.0.0 AGRCE-6PXRN-03GAXIKOEV-3UX1-MRAHH
MTICS 4.0.0 AWRWI-XDCEB-HKIEM-KRHAG-GXSYA-UPX3R
4| I +
Product ID: |MTICS
Wersion: fxxx) |4.D.D
Codeword: |AWRWI-XDCGB-HK3EM-KRHAG-GXSYA—UPX3R
Set I Clear | Delete

ok | Cancel | appy

6. Enter the ICS codeword information. Click the Set button.

Software License Codewords

MTICV 400 AGRCB-EPXRN-03GAX-KOBV-3UXI1-MRAHH
MTICS 40.0 AWRWI-XDCEB-HKIEM-KRHAG-GXSYA-UPX3R

AYJEE-AKXMP-HXGCK-HMKAR-2ZHAB-UIATE

1| [ +

Product 1D: |MTCP

Version: fcxx) |4.D.D

Codeword: |ﬁYJ EB-AKXMP-HXGCK-HMKAR-2ZHAB-U3ATS

ok | cancel | gy |

7. Enter the IDE codeword information (optional). Required only if you have purchased
this optional product.



8. Click the OK button to close the System Configuration dialog.

Note: You need to enter the ICS codeword again in the integrated Metrics ICS program.
See the information below for performing this important step.

To Enter the ICS Codeword Serial number:

1. Open the Metrics ICS program. Select the menu item Help » Codeword to open the
Software License Codeword dialog.

Software License Codeword =3

Please enter the Software License Codeword for the
ICS Product.

AWRZ-KXCEZ-HKIEM-1RHUD-GUJBA-UPXIR

| Ok | ‘Cancel|

2. Enter the ICS Codeword Serial number supplied via e-mail or on the product
registration certificate.

3. Click the OK button.



Configuring ICV

Probe Station Configuration

After installing Metrics ICV, it must be configured. The first time ICV is started, it will
automatically run the Configuration Wizard Utility. This utility will ask the operator a series
of questions to determine the correct configuration for the probe station drivers of the
Metrics ICV software.

Start the Configuration Wizard, follow these steps:

Development Probing Testing  Analysis Tools Help  Exit

Device Algorithm Module i Execute

Connect

Device

p FRun

Wafer

: . Test
VBScript List — = M
= A — 8
P is Script ap Run

Control

it ~
Backup Restore Config System ﬂETR'[E Plot Stats Analysis Help
KV g

K e tesation Syt

1. Open the System Configuration window by selecting Tools » System
Configuration or clicking the Config button.



-

System Configuration . )

About Information | |nstrument Library | Software License Codewords I Corfiguration Managerl

This product was developed and praduced by Metrics Technology,
Inz. Fartechnical support or sales information please call
011+ {505) 7619630 or visit our website http:/fwww metricstech.com

— Rurtime Information

Registration: |ML2ﬂDDDN
Wersion: I-H].ﬂ
Service Patch: IHFDD

— Product Information
MName: IMT|[:1.,I'

Version: |4.D.1]

Corfiguration Wizard |

Copyright 1996-2012 Metrics Technology, Inc. Al ights reserved.

QK | Cancel Apply

2. Click on the Configuration Wizard button found on the "About
Information™ Tab.
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Pleaze select the Manufacturer and Model of the probe station which iz part of
the test spstem fram the list below:

Frober Models

No Probe Station

Dema Semi-buto Prober

Demo Auto Prober

Alezsi G alasy Supported Models
ascade 5300

mit
Cascade P521
Electroglas 4080
Electroglas 2001
Electroglas 1034
F.arl Suzs PA/5200
F.arl Suss PA/S300
Lucas Signatone Probers
Micromanipulatar 4450
Micromanipulator 2360
Micromanipulatar 95920
TEL [PE/P12)
TEL195
TSK
Yectar Probers
Frober Yendor YBS cript Prober Driver

< m

Cancel | Help |

3. Select the Probe Station you are using then click Next.

e T ==

Fleaze select the GFIB address being used by the probe station fram the list
below:

GPIE Addresses

b

o

-m|ﬂnmhmm-muﬂnmhmm-

-

[
Frew | Finizh | Cancel | Help |

4. Provide the GPIB address of the station then click Finish.
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Instrument Configuration
The Configuration Wizard Utility will setup the probe station information, however
typically other components must also be setup in order to run the testing. These components

are setup manually by the user the first time the system is run. These configurations are then
saved and automatically loaded each time the software is started.

Instrument Library

The Metrics ICV Instrument Library contains setup information for the instruments
used by:

e The Device Connection Control (Switch Matrix).
e Instruments used by the Metrics ICV supplied algorithms.

e Probe Station Control.



Switch Matrix Configuration

Version 4.3 of Metrics ICV has completely integrated the Switch Matrix Control within
ICV. Therefore, the configuration of a switch matrix is now provided within the Metrics
ICV System Configuration.

¥

,
S ——————

— Instrurment Definition

Inztrurent definitions define parameters required bo communicate with an instrument connected to the
PL.

M arme: ISW"-"‘-"“I

D ezcriphion; ISwitn::h b atriv

Group: ISwitch ;I
Diiver: | siat5250 |

— Communications Setup

Physical Interface: IUr‘lifiEd GFIE [GPIE] LI
Frirmary Address: IEE

Communcations Yerfication [Mot Reguired]

ID Query Command: | Werify

[ Append CRALF to Query Command
[ Read Ouery Responze

Frew Mext Cancel | Help

1. Click the Add button to open the Instrument Definition window. Enter the
following:

Name- A unique name that identifies the instrument.
Description (optional)- Additional description of the instrument.
Group- Select “Switch” from the pull-down list.

Driver- Select the driver for your instrument from the list.

®o0 o

matrix through.

2. Primary Address- Enter the GPIB address of the switch matrix.

ICV Installation and Getting Started Guide
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Instrument Config

Pleaze preszs the Poll Configuration button to request the cofiguration information from the instrument.

Foll Configuration |

Instrument Configuration:

Finizh

Cancel | Help |

Click the Next button to open the Instrument Configuration window. Confirm
the instrument is connected to the GPIB bus and click the Poll Configuration

Clazz S
Type ATHZR0
] E52504
Werzion A.01.03
Murmn Units 4
[Irit1 SWITCH-1 D1 2-E52524 10=12 Matrix Switch
[Irit2 SWITCHA1 D=1 2-E52524 10212 Matrix Switch
Idrit3 M UH-1424-E52554 24 [Bx3] Channel Multiplexer
[Irit4 bl L-1324-E 52554 24 [343] Channel Multipleser
Prew
3.
button.
4,

Click the Finish button to complete the addition of the switch matrix.
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Instrument (SPA, CMU) Configuration

Metrics ICV Version 4.3 includes a collection of pre-written test algorithms. These
algorithms control selected CV and IV instruments. These instruments must be
configured in this section.

Note: The new Agilent B2900 and Keithley 2600 drivers use a new unified driver
for ICV and ICS. Please refer to the detailed driver manuals for more information. If
you are using ICS with other drivers you will need to configure the instrument in
that Tool as well.

Instrument Definition “‘ ‘ ﬂ

Instrument D efinition

Ingtrument defintions define parameters required to communicate with an instrument connected to the

Marme: |5F'-":"-'I

Description; |S emiconductod Parameter &nalyzer
Group: | Instrument j
Driver: Jiiat415x ~|

Communications Setup
Physical Interface: ||_|ni[ie_.,:| GPIE [GPIE) ﬂ
Primary Address: |1 7

Communcations Yerfication [Mot Required)

|0 Query Command: || eify

[ Append CRALF to Querny Cormmand
Hext Cancel ‘ Help ‘

[ Fead Query Response

1. Click the Add button to open the Instrument Definition window. Enter the
following:

a. Name- A unique name that identifies the instrument. 1If you will be
using the ICV algorithms provided by Metrics Technology, you
MUST name the parameter analyzer “SPA1” and the Capacitance
Meter “CMU1”.

Description (optional)- Additional description of the instrument.
Group- Select “Instrument” from the pull-down list.

Driver- Select the driver for your instrument from the list.
Physical Interface- Select the GPIB device you will connect to the
switch matrix through.

©T 00 o



2. Primary Address- Enter the GPIB address of the instrument.

i S ™
e

|l Flease pres: the Poll Configuration button to request the cofiguration information from the instrument.

Pall Canfiguration

Ingtrument Configuration:

Clazs I

Type aTa15

D 41562,

Wersion 01.06-01.09-01.00
GEMDLU FalSE

mit1 SMUT-HRSMU
nit2 SMUZ-HRSMU
nit3 SMU3-HRSMU
Unitd SkU4-HRSMU
nits WEUTASL
|nitE WELI2ASL
nit? WAL AL
nitg WL 2L
Mum Units g

Fresw | Finizh | Cancel | Help |

3. Click the Next button to open the Instrument Configuration window.
Confirm the instrument is connected to the GPIB bus and click the Poll
Configuration button.

4. Click the Finish button to complete the addition of the instrument.

Note: The communications server includes the driver "Unified GPIB" for
supporting both legacy GPIB communications and also LXI (TCP/IP)
communications for instruments that support these types of interfaces. The
"Unified GPIB" can and should be used to communicate with legacy GPIB
only instruments.



fbout Information  Instrument Librany | Software License Codmrdsl Configuration Managerl |
MName Description
Prober Int=GPIBO{GPIB); Addr=28: Driver=pdnucgpib: Probe Station
SWi Int=Unified GPIB(SPIB); Addr=22; Driver=siat5250; Switch Matric
SPA1 Irt=Unified GPIB{GPIB); Addr=17; Driversiatd1% Semiconductod Parameter Anz
4| ] | 3
add | Edi Delete |

QK I Cancel Apply

5. Click OK to close the Instrument Library configuration.
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Introductory Information

Goal of This Manual

The goal of this manual is provide a process for the user to be able to create a test
plan with Metrics ICV. A test plan will be created that tests two devices in the same
module structure. This plan will be executed across a wafer. The plan will then be
modified to execute this testing at several sub-die locations within each die.

The definition of the terms wafer, die, module, algorithm, and script will be
presented to demonstrate how they are used in this product and manual. In many
cases certain terminology used within this manual may have a direct correlation to
another term used within a specific company.



Chapter 1- ICV Getting Started Guide

Introduction

The first chapter of this self-paced "Getting Started Guide" introduces the Metrics
ICV software. This chapter also provides important information on software versions
and support.

Please note that each chapter builds upon the information presented in the previous
chapters. It is recommended that the material is followed in the order presented.

Topics Covered

What is Metrics ICV Software?
Overview of Metrics ICV Software
Updating Versions

Support



What is Metrics ICV Software?

The Metrics ICV Software is a test executive designed specifically for
semiconductor characterization and reliability applications. The environment is
designed to be flexible so that different applications can be designed using the same
system software. Customer applications range from incoming parts screening to full
wafer test. All of this can be accomplished from one software environment while
being required to write code either minimally or not at all.

Metrics ICV Controls:

Semiconductor Parameter Analyzers

C-V Meters

Switching Matrixes

Probe Stations

Thermal Ovens and Chucks (with optional Integrated Developer
Environment)

Development Probing Testing Analysis Tools Help Bt

Device Algorithm Module i Execute

Connect

Device

Test

- » Fun
= Script

-

Wafer

Test

VEBScript [
SN - ) - -
P Seript — 8 ap Run

Control

L -
Backup Restore Config System ﬂE]—Rl[E Plot Stats Analysis
KV e

W et Syt




Overview of Metrics ICV Software

Metrics ICV software allows for the testing to be designed using several
components. Each component can then be integrated into higher-level components.
The components are the module script, die script, and wafer plan.

Wafer Die
Liddd  oddd

Die Script

JAIl LI

l Module

Wafer Plan EEEEE
uinjaluls

Module Script

The wafer plan sequences the stepping of the probe station to each selected die.
Once the probe station is at a selected die location, Metrics ICV runs the selected die
script.

The die script sequences the stepping inside of a die and the module script to be
executed at the location. Each location (module) to be visited within the die is listed
in the die script. Metrics ICV steps to the Module location and calls the associated
module script.

The module script allows for the creation and ordering of all tests that occur without
moving the chuck or removing a part from the fixture. This typically includes the
changing of switch connections and execution of different tests.

Note: At run-time the test engineer selects the wafer plan and test script to be run.
This means that there can be many different die scripts and module scripts and the
appropriate ones are selected as needed. Each script is stored independently.



Determining Software Version

The software version and HotFix number are very important when requesting
support. Without this information it is impossible to provide efficient service. Please
be prepared to provide this information when requesting support.

-~

System Configuration | =

About Information l Instrument Library | Software License Codewords ] Configuration Manager ]

This product was developed and produced by Metrics Technaology,
Inz. Fortechnical support or sales information please call
011+ (505) 761-9630 or visit our website http://www metricstech.com

Runtime Information

Registration: |ru1L2'I]-I]-[I-[I'N
WVersion: |4.{|'.ﬂ'
Service Patch: |HF1]-|}

Product Information
MName: IMTICV

Version: |4.ﬂ'.ﬂ'

Configuration Wizard

Copyright 1996-2012 Metrics Technology, Inc. All rights reserved.

oK

To determine the software version:
1. Open the ICV main window.

2. Select Tools » System Configuration or click the Config button.

3. Click the "About Information" tab.




Updating the Metrics ICV Software

Please keep your software up to date by downloading and installing the Metrics
Technology Hot Fixes. Your software will occasionally remind you to check for
updated HotFixes. HotFixes are critical updates for any discovered defects. Often the
issues addressed in the updates are ones that you may just now be encountering. The
latest Hotfix contains all previous Hotfix resolutions.

Metrics Technology also provides a Service Pack when necessary. A Service Pack
will contain all HotFixes and new program features. Once a Service Pack has been
created and verified by Metrics Technology, it is placed on our website;
www.metricstech.com. Please note the Service Packs are very large and will take time
to download depending upon your connection speed. Once downloaded the file is an
.EXE application.

Support

Metrics Technology provides technical support to customers for one year after the
purchase of the Metrics software. This support period includes a ninety-day period
when telephone support is available. The remainder of the year’s support is provided
by email. Information on how to set-up instruments can be found under the HELP
tab of the software. Please visit our website at www.metricstech.com to register your
software and obtain your log-in credentials. Your account will be activated within 24
hours.

If you are a customer that has registered and been provided log-in credentials you can
access our Knowledge Base through your Customer Portal. If your issue is not
addressed in the Knowledge Base it is most efficient to assist you if you submit a
support ticket through your Customer Portal. Please provide the following
information:

1. Your software License Number (also known as Customer ID (CID) /
Registration number). The sequence will be TAXXXXXA, THXXXXXA or
MKXXXXXA, etc. (X represents a number).

2. Version of software and last HotFix applied. If you are using a currently
supported version be sure you have applied the latest HotFix (HF##) available
at our website accessed through your customer portal.

3. List of equipment you are using to test your devices.

4. The ICS project file or VBScript algorithms being executed.

5. Screen shots of the error code (Alt->Prt Scr, or Shift-Command-4 for MAC)
to capture the error window. Images sent from a camera are often illegible.


http://www.metricstech.com/
http://www.metricstech.com/

Chapter 2- Starting ICV

Introduction

The second chapter of this self-paced Guide will cover the
Metrics ICV toolbar and the functions available. This chapter
will also provide an overview of the steps required to create a
test. Subsequent chapters will provide the details regarding test
creation.

Topics Covered:

e The Metrics Program Group
e The ICV Toolbar
e Overview of Test Development



The Metrics ICV Program Group

When Metrics ICV is installed upon the system, a new program group and a desktop
shortcut is created. The program group is called Metrics and can be found by
clicking Start -> Programs -> Metrics. Inside the group are several links to different
pieces of the Metrics ICV software. An example of the desktop shortcut that is
created is displayed below. This shortcut will open the ICV navigation window.

Id

1 TRIEN]

The Metrics ICV Toolbars

Metrics ICV contains a single toolbar that is used for the creation and execution of
tests. All of the tasks for creating the test and executing it are accessible from this
window.

Development Probing Testing Analysis Tools Help  Exit

Device Algorithm Module i Execute

Connect

Device

Test

- - Fun
= Script

-

Wafer

Test

VEBScript Ma
R : — = e e <
" script P Run

Control

Y ~
Restore Config System ﬂETR'[E Flot Stats Analysis Help
KV g

W et Syt




Metrics ICV Menus

The Metrics ICV navigation window has both menus and buttons on it. The
menus contain shortcuts to the tools that are used with Metrics ICV.

Development Menu
When creating or editing a test, the Development menu is used. This menu
includes access to the Device Connections Editor, Algorithms, Module Test
Editor, Module List Editor, and Die Test Editor.

Probing Menu
The Probing Menu contains the applications needed to specify and test the
wafer prober stepping control. These include the Wafer Map Editor, Probe
List Viewer, and Prober Control.

Testing Menu
The Testing Menu contains one application, Run Test. This is the same as
clicking the Run Test button on the Metrics ICV Toolbar. This will begin
the process of running a test.

Analysis Menu
The Analysis Menu contains links to both the Data Browser and the Miner
applications. The Data Browser allows the viewing of the raw data vectors.
The Miner allows the creation of wafer maps of a Toolbar for starting them.

Tools Menu
The Tools Menu is a collection of applications for the maintenance of the
system as well as other ancillary applications. These include Backup and
Restore utilities, access to the System Configuration, and a link to the
Metrics ICS tool which can be used to create algorithms.

Help Menu

The Help Menu is a direct link to open the online help manual. The Help
button on the Metrics ICV Toolbar has the same function.



Metrics ICV Toolbar Buttons

The Metrics ICV Toolbar Buttons are the shortcuts to controlling and
viewing test data.

Run Test Button

The Run Test button opens a dialogue box that allows the user to select the
wafer plan, test script, and data location for the execution of a test.

Probe Control Button
The Probe Control button opens the Interactive Probe Station Control. This
application provides and environment to confirm both that the probe station
communication is working and the wafer plan setup is correct (die-to-die
distances and module-to-module distances).

Plot Browsing Button

The Plot Browsing button opens an application that allows the plotting of
data vectors from the wafer data collected.

Stats Analysis Button
The Stats Analysis button opens the Miner application. This application
provides the capability to create and print histograms and wafer plans for the
collected data.

Help Button

The Help Button is a direct link to open the online help manual. The Help
menu on the Metrics ICV Toolbar has the same function.



Test Development in Metrics ICV

Test Development within Metrics ICV is a process of collecting the appropriate
components together to perform a wafer test. These components include a wafer
plan, module tests, die tests, and test algorithms.

A Top-Down Approach

When developing a test, a series of decisions are made. Looking at the
information required from a top-down approach, the following list of
questions is answered:

What wafer is to be tested?

What are the die size of the wafer?

What die locations do we want to test?

What module(s) do we want to test within the die?
What test scripts are run at each module?

If testing multiple modules, how far does the probe step to
move between modules?

What devices do we want to test within the module?
What device pins are connected?

. What tests do we want to run on the device?

0. How do the tests work?

o E

Metrics ICV’s Approach

By answering these questions, we have a very good idea of how the test
should run. But how does this map to the Metrics ICV software? The
information below provides a mapping of these functions.

Metrics Wafer Map Editor

The Metrics Wafer Map Editor provides the facilities for creating a wafer
map which stores the information required to answer the questions.

e What wafer is to be tested? Each map can be named to represent a
specific wafer and testing pattern.

e What are the die size of the wafer? Each map contains the X and Y
die size.

e What die locations do we want to test? Each map contains the die
that are selected to visit.



Die Test Editor
The Die Test Editor is a script generator that allows for the selection of the
module locations to visit and the module script(s) to execute at the specific
module.

e What module(s) do we want to test within the die?
e What test scripts are run at each module?

Module Test Editor

The Module Test Editor is a script generator that sequences the selection of
devices within a single module and the tests to be run.

e \What devices do we want to test within the module?
e \What tests do we want to run on the device?

Module List Editor

The Module List Editor provides the facilities for defining the offset
distances between modules within a die.

e If testing multiple modules, how far does the probe step to move
between modules?

VB Script Algorithm Editor/ICS

The VBScript Algorithm Editor and/or Metrics ICS provide the facilities for
defining the test methodologies for each device.

e How do the tests work?
Device Connections Editor
The Device Connections Editor is a graphical control for the switch matrix.

e What device pins are connected?



Below is a graphical representation of the components and how they relate to one
another.
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Chapter 3- Creating Device Connections

Introduction

The first step to creating the complete test plan is to configure device connections
that allow the instrument to connect to the device. This is the case in systems that are
using switch matrices and probe cards. If your system does not, skip this section and
omit any switching control from further plan development.

This chapter details how to create device connection files and their use within
Metrics ICV. The following instructions require that the switch already be
configured according to the “Switch Matrix Configuration” section of this manual.

Topics Covered

What is a device connection?
Creating device connections
Testing the connections

Saving the device connection File



What is a Device Connection?

A device connection is the connection path that is made within the switching matrix.
Typically the SMU or CMU is connected to the Input of the switch matrix.
Typically the probe card or manipulators are connected to the output of the switch
matrix. The device connection is the path that is made between input and output of
the switch matrix.

Switch Matrix

QO0000000 DI..I’[FIUJ[S Probe Card

DC Meter
coeg PP ooo  Inputs



Creating Device Connections

Device connections are created within the Device Connection Editor. The editor is
accessed by selecting Device Connections Editor in the Development Menu of
Metrics ICV. At this point the goal is to create a collection of input/output
connections that create matrix cross-points on the matrix cards that connect the
source units with the pins of the device.

To Select Input/Output Connections:
Step 1: Select and name the Connection

1. Open the Device Connections Editor Development » Device
Connections Editor or the Connect button.

-
Device Connections Definitions 2@_

Please uze the buttohs to edit the list of Device Connections which will be
avallable for use in algorithms.

Device Connections

&dd

Irmpart

LRk

4 1 I

‘ Finizh ‘ Cancel ‘ Help ‘

2. Click the Add button to begin the creation of a new Connection.



5] File Selection

'\:J\J [Jl « BOOTCAMP (Ci) » dev b metrics » bin » DevCons 4]

Search

i Favorites
B Desktop
& Downloads

Y
=1 Recent Places

) Libraries
3 Documents
J? Music
= Pictures
[=°] Subversion

B Videos

M Computer

Crganize » MNew folder = - [ u@u

Marme Date modified Type Size

| | dl.dec 8/14/2012 7:20 AM  DCFile
|| nmos test.dci 2/24/2009 8:53 AM  DCIFile
|| vimos.dc 8/14/20129:16 AM  DCFile

m

- 4| L 3

File name: *.dc - [Device Connections VI

| Open |v] | cancel |

Using the File Selection Control, enter a name for the connection in
the File name field and click Open.

Note: Subdirectories can be created to group switch patterns based
upon the module they are used within.

Note: Only switch patterns saved within the Metrics\DevCons
directory will be saved when using the Metrics ICV Backup utility.



Device Connection Definition

|| Pleasze specify the desired switch input bo output connections using the fields below.

|| Label d1
Switch batrix: Sl
= S

Card 1

Outputs
11238 516716l al1diil12

Inputs

Il ake Connections Mow Clear Connections Mow ‘ Finish ‘ Cancel ‘ Help ‘

4. Select the switch that will be used.

Note: If only one switch card is configured in the ICV System
Configuration, then the Select button will be inactive.

Card 1
Outputs
1213l 4]slel7]lelalio1]14
1] %] 0
2 %] 0
3 %[0
4 %[0
Inputs 5] & 0
B %[0
7 %[0
8 %[ 0
a9 %[ 0
10 %[ 0
><|><|><|>a:|>=:|xlxlxlxlxlxlxlﬂ

5. Click the “o0” at the junction of the input and output that corresponds
to the desired switch path connection. Alternatively, click the label
of the input and then the label of the output to mark their intersection.



-

Device Connections Definitions

Please uze the buttons to edit the list of Device Connections which will be

available for uze in algorithms.

Device Connections

b

q I |

Frewv

Firish

Add
Edit

Delete

Irmpart

ok

Cancel

Help

6. Click the Finish button to return to the list of defined device

connections. Clicking Finish saves the new switch setting definition.
7. Click Finish to exit the Device Connections Editor.
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Testing the Connections

After creating a device connection, the Device Connection Editor provides a
capability to manually execute the device connection. This feature has two primary
uses:

e To test the switch path (with a DVM).

e To allow the execution of an algorithm for debug testing.

The Make Connections Now button sends the commands to the switch matrix for
closing the selected cross points. The connection pattern remains on the switch card
until either the power to the switch matrix is switched off or a different set of cross
points is sent.

kake Connections Mow Clear Connectionz How

To verify the connections:

1. Click the Make Connections Now button.

To clear the connections:

1. Click the Clear Connections Now button.

Saving the Switch Connection File

Unlike previous versions of the Metrics Switch application, Metrics ICV software
automatically saves the switch pattern. Thus there is no need to manually save the
device connection.



Chapter 4- Creating Measurements

Introduction

The next step to creating a test plan is to create the individual measurements. These
measurements are created within the Metrics ICS software or Visual Basic Script.

This chapter specifically deals with using Metrics ICS to create the measurements.
The Visual Basic Script editor is described within the IDE - (Integrated Development
Environment) Reference Manual.

Topics Covered

What is Metrics ICS Software?
Configuring ICS

Creating a Sweep Measurement
Creating a Spot Measurement
Saving the Measurement

This chapter introduces the Metrics ICS (Interactive Characterization Software)
measurement engine and demonstrates how to create measurements with it. Special
demonstration drivers have been created to allow the development to be independent
of the instrument. For details about the instrument drivers provided with Metrics
ICS, please refer to the Metrics ICS documentation. The steps to creating a test
method will be covered.

Note: This is not complete coverage of the Metrics ICS test engine. For a more
thorough discussion of ICS please refer to the ICS Technical Reference Manual.



What is Metrics ICS?

Metrics ICS (Interactive Characterization Software) is a software application that is
used by Metrics ICV as a measurement engine. Metrics ICS provides a windows
based environment for creating measurement using a point and click methodology.

For measurement development the Metrics ICS environment can be used stand-
alone.

Metrics ICS is:

Measurement Engine
Windows based

Point, Click, and Measure
Non-automated Applications

Start Metrics ICS by selecting Development >> Algorithm Editors >> ICS menu
item or click on the ICS button.

File Instruments Measure Opticns Window Help

vii /B #% S 9 E | WEH = [ B8
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Configuring Metrics ICS

Before creating a measurement, Metrics ICS must know what instrument is being
used. This is accomplished by configuring the instrument in ICS. Once an instrument
has been configured, ICS will remember this configuration. The only time ICS must
be reconfigured is when the instrument is changed or the ICS40.INI file is erased.

~d
W,

1. Click the "Select Instrument™ button.
2. Highlight the instrument to be added and click the "Connect™ button.

-

Instrurments

Available

% |

Selected

YT - demon
atd 284 I

atd 284

atb1500

atb2800

ate4930

After the Instrument driver is selected, it must be configured.

1. Highlight the instrument to be configured and click the Config button.
2. Enter the GPIB address.



Polling an Instrument

To confirm that the instrument and Metrics ICS are communicating properly, poll
the instrument.

Configuration =
GPIE D R.OM Version
1 Pemn IV Instrument | |1.D.I] |

[ oK ][Cancel][ Poll ]

1. Click the Poll button.
2. Click the OK button to close the Configuration window.

3. Click OK button to close the Instruments window.



Create a Sweep Measurement

The following example demonstrates how to create a sweep measurement using ICS.
This example uses the demonstration driver within ICS.

To Create a Sweep:

1. Open the setup editor.

The Setup Editor is the dialog in Metrics ICS where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor [ =2 |
Mew Devices Sources Options
Copy Rename Delete Time

—TX

2. Click ""New' to create a new setup



3. Name the Measurement Setup.

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

-

Mew Setup 2|

Mame: SWEEP

| oK || Cancel |

a. Click the OK button after entering the name.

4. Select Source Units.

The source units correspond to the outputs of the instrument you are using.

Metrics ICS provides a graphical way to document the connections for later
reference. To add a source unit:

Setup Editor \E\

| New | Devices || Sources | options |

[ Copy " Rename ” Delete " Time._. l [SWEEF' vl

Source Units | 22|

DEMOIV.SMUA1 -
] DEMOIV_5MU2

DEMOIV.SMU3
DEMON.SMU4
DEMOIV. VS
DEMOINV VS2
DEMOIV. VM

m

1

[ Instruments ]

[ Source Units ]

! o

a. Click on the Sources button to open the Source Units window.
b. Highlight the specific unit.

c. Click the blue box beside the device lead in the Setup Editor.




To remove a source unit:

a. Highlight the attached unit.

b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button when asked if "Do you really want to remove the
source".

rSetup Editor (S |‘
| Mew ” Devices || Sources " Options |
| Copy || Rename || Delete " Time... | [SHUEEP -

SMUA

SMU2

SMU3

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to
exactly match, rather it is only for reference.



5. Configure Source Units.

In this example we are creating a sweep source, so we must configure the
source unit properly. To setup a sweep source:

SMUA

SMU Setup £X
Source: | oMUl
Stimulus Measure Sweep Time
@) Voltage ¥|voltage WD Hold 0.0000
Current | Current ID Delay 0.0000

Force Conditions

Mode | SWEEP Start 0.0000 Volts
Type |LIN - Stop 5.0000 Volts

Mo, Points 51

Compl  0.1000 Step Size  0.1000  Volts
Time Stim Time Measurement Bias
@ Voltage Time Bias  0.0000  Volts
Current Compliance  0.1000
| Ok | | Cancel |

Select the stimulus type.

Select the values to be measured (see note below).

Click the blue box beside the device lead in the Setup Editor.
Select the sweep timing (see note below).

Select the Source Mode. In this case we want it to be Sweep.

a.
b.
C.
d.
e.

Setup the sweep parameters.

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. The Sweep Time parameters are to control
the rate of the sweep. Please note that these inputs vary for different
instruments.



Create a Spot Measurement

In this example we will create a spot (or single point) measurement. Most of the
steps are the same or similar to creating a sweep measurement. The first step is to
open the setup editor. The setup editor can be opened by clicking the Setup Editor
button.

To Create a Spot Measurement:
1. Open the setup editor.

The Setup Editor is the place in ICS where the measurement is configured. It
can be opened by clicking the Setup Editor button.

Setup Editor [ == |
Mew Devices Sources Options
Copy Rename Delete Time
I¥




2. Name the Measurement Setup.

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

-

Mew Setup

MName: SPOT

o)

| & |

ook

| Cancel |

a. Click the New button and type in a name.
b. Click the OK button after entering the name.
c. Select Source Units.

The source units correspond to the outputs of the instrument you are using.
Metrics ICS provides a graphical way to document the connections for later
reference. To add a source unit:

’SetupEd'rtor @
| Mew || Devices || Sources || Options |
| Copy || Rename || Delete || Time.___ | ISPQT ,]
’SnurceUnits [ E2 |‘
DEMON SMU2 -
D DEMOIV_SMU3
DEMON SMU4
DEMON W51 =
DEMON V52
DEMON W1
- DEMOIV. VM2 -
= [ Instruments ]
[ Source Units ]
| | Done |
]

=

a. Click on the Sources button to open the Source Units window.



b. Highlight the specific unit.
c. Click the blue box beside the device lead in the Setup Editor.

Setup Editor @

| MNew ” Devices “ Sources ” Options |

| Copy |‘ Rename H Delete ” Time._.. | |SPQT v|

‘ Done

To remove a source unit:

a. Highlight the specific unit.
b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button.

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to
exactly match, rather it is only for reference.



3. Configure Source Units.

In this example we are creating a spot source, so we must configure the
source unit properly. To setup a spot source:

SMU

~

SMU Setup [
Source: | SMU1

Stimulus Measure Sweep Time
@ Voltage /| Voltage vD Hoald | 0,0000
Current | Current 1D Delay | 0.0000

Force Conditions

Mode | CONST *r| Value [p.0000 | valts

Compl  0.1000

Time Stim Time Measurement Bias
@) Voltage Time Bias  (0.0000  Volts
Current Compliance 0. 1000
| (84 | | Cancel |

Select the stimulus type.

Select the values to be measured (see note below).

Select the Source Mode. In this case we want it to be Const.
Setup the source bias.

o0 o

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. Please note that these inputs vary for
different instruments.



Executing the Measurement

The measurement mode is Standard by default. Thus all of the previous
measurement types (sweep and single point) did not need this value changed.

To access the Measurement Remote control click on the Measure button on the ICS
toolbar.

To Execute a Measurement:
1. Make sure the measurement name is displayed in this box.
2. Use the pull down menu to select the Standard mode.

3. Click the Single button to execute the measurement.

This toolbar contains buttons to begin the measurement as well
as menus to select the measurement and mode.

Measure

Single

>

? Repeat
W Append
Histony

E Auto

y ZER
I ISR SThEas

STEY ZER
@ CAMNCEL

B | Stop

At this point the software will communicate with the
instrument and execute the measurement.



Data Return

Metrics ICS (Interactive Characterization Software) automatically returns the data
from an executed measurement. The data is presented in a built-in spreadsheet. The
spreadsheet is automatically created when a test setup is created. It will begin as a
minimized window in the lower left corner of the ICS window. To view the data
simply double-click the window that has the same name as the test setup.

I VTH E=N EoR|E
[ Clear H Max H Min ][ Direct ] 08072012 1
ID e |VT + |GM = |GMMAX + | TFIT = -

1 0.0750p 0.0000 15972 09307 200000 -D5388m

2  0.1680p 0.1000 1.8787p -0.5519m

3| 04507 0.2000 5.9548p 0.5151m

4 1.3590p 0.3000 0.0192n 0.4782m

5 42856 0.4000 0.0642n 0.4414m

6 0.0142n 0.5000 0.2216n -0.4045m

7|  0.0436n 0.6000 0.7388n -0.3676m

g  0.1740n 0.7000 3.0511n -0.3308m

3 065380 0.3000 0.0117u -0.2939m

10|  25201n 0.5000 0.0458u -0.2570m

11 9.8193n 1.0000 0.1850u 0.2202m
) 1% N NGR 1 1 N 700 _r'l‘Iﬂ:l;nlJ




Saving the Measurement

The last step to creating measurements is to save them. A measurement or collection
of measurements is saved in a Project File. To save a project file select Save As ICV
Algorithm from the File Menu of ICS, select a directory, enter a name, and click the
OK.

o J

Note: Project Files can be saved in any directory. However if you plan to use the
test with ICS it MUST BE SAVED IN THE METRICS\ALGS DIRECTORY or a
sub-directory within the Metrics\algs directory.

File Save As (23]
-~ . v Computer » BOOTCAMP (C:) » dev » metrics » bin » ics » projects ¥ | ¢ || Search projects Dl
[

Organize = MNew folder =~ [ @l

¢ Favorites gt MName Date modified Type Size gt
Bl Desktop [ b1505-dinde 9/29/2011 7:29 PM  iCalendar File 13 KB
& Downloads [ B2900test 7/21/201210:31 AM  iCalendar File 15KB
5 Recent Places [ B2900test2 7/28/201211:15 AM  iCalendar File 10 KB
rﬁ ics2600-mos 7/11/201210:31 AM  iCalendar File 26 KB
@ Libraries = [ ics4145-mos 8/6/201212:59 PM iCalendar File 15 KB
3 Documents [ ics#156-diode 6/27/2012 4:45 PM iCalendar File 12 KB
J'- Music :ﬁ ics5270vt 11/21/2011 8:432 AM  iCalendar File QKB

=] Pictures :ﬁ 1cs5270vE 11/21/2011 1:28 PM  iCalendar File 13 KB E
[ Subwversion :ﬁ icsatd145 8/6/2012 2:23 PM iCalendar File 11 KE
E Videos :ﬁ icsh2900-mos 7/24/2012 2:16 PM iCalendar File 9KB
b ;‘E icsh2912-mos 7/25/2012 9:56 AM iCalendar File 16 KB
1% Computer :ﬁ icsKI2600-fast 7/24/20121:34 PM iCalendar File 17KB
S escher (\\terastni [ o142 3/5/200912:24 PM  iCalendar File 58 KB
’:-_“-'. BOOTCAMP (C:) :E icvd145 3/5/200912:24 PM iCalendar File 56 KB
a Macintosh HD (E [ o156 3/5/200912:24 PM  iCalendar File 42 KB

—a GMax (F) T icv284 3/5/200912:24 PM  iCalendar File 20 KB L4
¥ dev.Advanceding [ icvkB2 3/5/200912:24 PM iCalendar File 31KB
=¥ prod.Images (WG ] icvkao 3/5/200912:24 PM  iCalendar File 712 KB

S :‘:ﬁ L FRAN IR NN 04 DA W alamd e Ciln 10 vo S

File name: | - [ICS Project (".ics) ']

Com ) |

Cancel




Chapter 5- Creating a Module Test

Introduction

The next step in creating a test plan is to build a module test script containing the
ICS algorithms and device connections. The module test designates the order in
which actions occur during testing of a specific module.

Topics Covered

e What is a Module?
e What a Module Test Does
e Creating a Module Script



What is a Module?

Metrics ICV uses the concept of a Module to define a level of scripting available in
the design of tests. At some companies, the module is called a sub-die, quad, or
TEG. Metrics ICV uses a definition which is based upon the function and equipment
of the specific test system it is installed upon.

A module is all of the devices that the probe needles are able to touch at the same
time (without moving the probe chuck, needles, or platen).

Below are two examples of modules. The picture on the left is the case where the
probe station has a 2x6 probe card. The probe needles can touch the 12 pads at the
same time without having to move the probe chuck. The picture on the right is the
case where the probe station has 4 discrete positioners and only 4 device pads can be
contacted at the same time without moving the chuck or positioner.




What a Module Test Does

A module test is a collection of the tests that are to be performed at a specific module
location. If the probe system is using a probe card and switch matrix, then the
module test would control both the setting of the switch matrix (device connection)
and the running of test algorithms (ICS or VBScript) for any of the devices within
the module.

Wafer Plan [Yie Plan Module Plan

Start
=

' '
»| Step Next Die | Sl dnat " Run Tests
/ [ T —
I ' p ]
- Call Module Script |, i
Call Die Scrpt L Pt *x\\ Switching
) T -\.l-." M ’-__f.-'l.'\-»,_h \Il. ¥
- -___,_,-"'ffﬂﬁ'““-v,__\_‘h ! __.-d""'-.--. H_‘H“'“x,_\_‘ .\x"q__ Dlecision I"-'Iﬂk_'i.'llg
. el . | ——<_Last Sub-Die? >
_E'IH-H"‘-. Last The? F#;\" '-,_\ ~ .a"'--'
H-\"h_x\- ___.-'"--' "'\ 5-\"'\.1_‘._ .-'"'.-
""--\.-"'--l \"--L_\__ o
Yes Yes

| Stop |

The module test is typically called by a die test script (see next chapter).



Creating a Module Test Script

Module Test Scripts specify and control all of the testing performed without moving
the wafer chuck. Algorithms can be combined with device connections (Switching),
If-Then structures, and Variables to create a testing solution.

Description: |EE

1] BEG Connect Device [ wimosz | Add Line

2] Execute Algorthm [ ICSYhpd156-wtmos - WTOS | e L
3 Execute Algorithm [ ICS5hpd156-wtmos - RDS_OM | —_—
4] END

Delete Line

Edit Line

Move Up
Maove Down
Capy

Paste

Comment

Mew Line

T

Globals

Froperties

1 LI ¢ Repartz

Fiun Debug Print Save Save bz | (n] 4 | Cancel




To create a Module Script:

1. Open the Module Test Editor by selecting Development >>Module
Test Editor menu item or Test Script button in the Module area of
the Metrics ICV navigation window.

I File Selectior ==
'. ' o % Metrics » scripts » modscripts - Search modscripts pe

Organize « MNew folder

5 Downloads o Mame Date modified

| Recent Places )
[ Demo Medule Script 5/30/2012 8:28 AM

[m= ic s vtmos 8/14/2012 9:57 AM

= Libraries
- E| icv_vtrmos 8/4/2012 2:32 PM

3 Documents
J’- Music
=] Pictures

B videos

1M Computer
‘-'é Mew Volume (C:)

i Local Disk (Tn) + o |

File name: ~ | MODTEST (*scr)

Open - Cancel
|

2. Select a name for the new script and click the Open button.



D escription: |new module]

Add Line
Insert Line
Delete Line

Edit Line

Move Up
tave Down
Copy

Pazte

Cormrment

MHew Line

T

Globals

Froperties

Reports

| Save | Save &g | Ok | Cancel

3. Enter a description in the Description Field.
4. Click the Add Line button. Select the Connect Device item and
click the Finish button.



Description: |mew test

Component Manager

4 Wariables
B3 Create List
L[] Shep List
[ Create Variable
a Script Flow

: ELSE
B Assigh
a Switching

a Algarithms
“[E] Ewecute Algorithm

Cancel |

5. The Device Connect Sequence wizard will open. If you wish to run
the same tests on a series of devices within a module, you can select
all of those devices from this dialog and setup their order of
execution.



r

Device Connection Sequence

Pleaze uze the buttons to edit the list of Device Connections to be called. The
lizt can contain a gsingle device connection or multiple device connechions. |
multiple device connections are selected, the connnectionz will be executed in
the arder specified in the list.

Device Connection Seguence

4 UL P

‘ Finizh

Add

Delete

Maove Up

dd]

bd v Doy

Cancel ‘

Help ‘

Click the Add button to begin creating a list of device connections.

6. Highlight all of the device connections you wish to add to the script

item.



Pleaze zelect the Device Connections to be executed from the lizt below. Use
the Mew button to create new Device Connection definition and add it to the list.
Iz the Edit button to edit a connection.

Awailable Device Connectionz

Finizh Cancel ‘ Help ‘

7. Click the Finish button to return to the Device Connection Sequence
window.



Device Connection Sequ -

Pleaze uze the buttons to edit the lizt of Device Connections to be called. The
lizt can contain a gingle device connection or multiple device connections. |
multiple device connections are selected, the connnections will be executed in
the order zpecified in the lizt.

Device Connection Sequence

wimoz-d1
wtmos-d2

Delete
Move Up

Miowe Down

k

Finizh ‘ Cancel ‘ Help ‘

8. Highlight any of the connection names that you wish to change the
order and use the Move Up and Move Down buttons to change the
order of execution.



Description: [hew module

1] BEG Connect Device [ Multiple | Add Line
2 END Inzert Line

Delete Line

Edit Line

Mowve Up
Mo Down
Copy

Paste

Corment

MHew Line

[ B |

Globals

Froperties

1 m L Reparts

Run | Debug | Frirt | Save | Save bz | oK | Cancel |

9. Click the Finish button to save the device connection sequence to the
module test script.

10. Highlight the END statement and click the Insert Line button to
begin adding an algorithm to the module test script.



Description: |new module

-
Component Manager

‘4 Variables

i Create List

H Step List
‘o Create Yariable
=3 Seript Flow

i Collect

LB F

[E ELSE

LB Assign

A Switching

‘. @ Cannect Device
=3 Algarithms

Firizh Cahcel ‘ Help ‘

11. Select the Execute Algorithm function and click the Finish button.



D escription: |new rnodule

gl Algorithm Selection

Available Algorithms;

| e hpé15E-dinde
- hpd155-vimos

- iceb2800-mos
[ REL_WLR
[#- Samples

12. Choose the algorithm to run by highlighting the name of the
algorithm and clicking the Select button.

Note: This window is displaying the contents of the Metrics\algs
directory.



-

adl ICS Setup Selection ==

Pleaseselect an IGS test setup to be executed from the available
ICS setups list.

Current Project File:
ChMetrics\algs\CSics4156-mos.ics

Available ICS Setups
WTISAT)

IDS{0M)

ID(SAT)

0SS

VDSS

ISUB

IGATE

DRAIN FAMILY
GATE FANILY
BODY BIAS FAMILY

Select Cancel

13. In the case of an ICS algorithm, Choose the test from the list and
click the Select button.
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IS

-
Input Parameter Definitions M

— Execute Algonithm

Input Parameters Data Source

externglobl [Doublesg) Drefault -
externglob? [Doubles) Drefault =
externglob3 [Doubles) Drefault E
externglobd [Doubles) Drefault

Strezz Time [Doubles) Drefault

YOAMBLLE [Doubles) Drefauilt

YWO-COMPL [Doubles] Drefauilt

WGE-START [Doubles] Default &
4| mn | b

— |nput Parameter D ata Source

£ Use Default Yalue as [nput Data

€ Use Data from Another Script llem as [nput Data

— Object to Uze a the [nput's Data Source
Source Scnpt Object:
| =l
Source Dutput Farameter:
Set Data Source
Fres | Finizh Cancel Help

£

14. The next dialog allows the passing of inputs into the test. In this case
we will skip this function and just click the Finish button. Please
refer to the Metrics ICV Reference Guide for more information about
mapping input parameters.

15. Save the module test script.
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Description: |hew module

Add Line

BEG Connect Device [ Multiple |

Execute Algarithrn [ 1IC54ice4156-mos - VT e i

1]
2)

k]

EMD
Delete Line

Edit Line

Maove Up
Move Dawn
Copy

Pazte

Camment
Mew Line

Dizable

Edit Inputs

Globals

Froperties

r

ok | Cancel |

Reports

Save | Save As |

In the example above, all of the testing is performed from within a module
script. This means that all of the devices being tested are part of the same
structure and the wafer chuck is not being moved to reposition the wafer

between tests.



Chapter 6- Creating a Module List

Introduction

The next step in creating a test plan is to build a module list. The module list is a
collection of the locations of the modules within a die. All locations are made
relative to a single reference position.

Note: If you are not planning to perform sub-die stepping you can skip this chapter
and Chapter 7.

Topics Covered

What is a module list?

The coordinate system of the module list
Creating a module list

Importing a module list



What is a Module List?

A module list is a collection of the modules contained within a specific die reticle.
The module list contains both the names and positions of the modules within the die.
The module list is a convenient way to save this information and the list is
independent of wafer maps. Thus if you have different stepping plans for the same
wafer types, you can reuse the information stored in the list.

A module list contains all of the module locations entered by the operator. Not all
of the locations must be used during test setup.




The Coordinate System of the Module List

The module list uses a standard X-, Y- coordinate system for the definition of
distances between modules. When standing in front of the wafer probe station
looking down upon the wafer chuck, positive X is to the right and positive Y is away
from you (Up).
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If the wafer is rotated 90 degrees, then the X and Y distances transpose. This must
be taken into consideration if the wafer is loaded upon the chuck with the notch or

flat rotated.
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Creating a Module List

The module list is created by using the Module List Editor found in the Development
menu of Metrics ICV. All distances used in the Module List Editor are in microns.
In addition the distances are defined as the distance to move from one module to
another. This is illustrated in the following diagram:

b/ <

) 1600 microns
800 microns

A EIEII:II:IEIEI I:IDDEIEIEI I:IEIEIEIDEI
O0O00000 O0O00000 O0O0000

Y Oooooo 00o0oo 0ooooo
000000 000000 000000
OOooooo Oooood oooooo
OOO0000 OOoood Ooooood

Oooooo oooooo oooooo
Oooooo 0ooooo oooooo

SuoJoItuI ()G [

suoIoTw ()0 <

X

In the above diagram the module named Al is treated to be the reference location.
The reference location (0,0) is the location that the wafer MUST be positioned
to when starting an automated test. In the case of auto probe stations, the station
must be programmed to load to this module when the load command is sent to it.
The location of the reference location is up to the user. However, the user should not
change the reference location unless they erase all old maps. Otherwise the previous
maps will not function correctly.



Based upon the diagram and the coordinate system, the Modules would be defined

Module Name X Coordinate | Y Coordinate
Al 0 0

A2 800 0

A3 1600 0

Bl 0 -150

B2 800 -150

B3 1600 -150

C1l 0 -300

C2 800 -300

C3 1600 -300

Note that the reference location is ALWAYS defined as 0,0.

To Create a Module List

1. Open the Module List Editor. Select Module List Editor from
the Development menu or click the List button in the Module
area of the Metrics ICV navigation window.

' )
. .' -« Metrics » WaferMa - | + Search WaferMaps

Organize » Mew folder

Mame Date

e

- Favorites
Bl Desktop
4+ Downloads

1/27/2012 7:34 AM

8,7/2012 5:39 PM

|E| Demo Module List

|E| icv-mos

Movie Clip
Movie Clip
£l Recent Places

=3 Libraries
3 Documents
J’- Music
| Pictures

E Videos

M Comniter sl <

File name: icv-mos - [Module List (*.mod)

’ Open |vl ’ Cancel

2. Enter a name for the new module list and click the Open button.



3. The Module List Editor will now open.

Fleaze define the modules to be included in the module list uzing the buttons
below.

M odules

Load File

Finizh Cancel ‘

4. Click the Add button to add a module location.



-

Module Location Definition

— Module Location Definition

b odule Mame:

todule Location D efinition is uzed to specify the location of a Module within a die location.

[

todule Offzet from Dig's Origin (urm)

0 Offzet [um); ||:|

Y Offzet [um]: |I:|

Fres Finizh

Cancel

Help

ICV

5. Enter the Module Name, X Offset, and Y Offset and click

Finish.
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Fleaze define the modules to be included in the module list using the buttans
below,

t odules

Delete
Mowve Up
Maove Do

Load File

3

Finizh ‘ LCancel ‘

6. The location will be added to the list.



7. Repeat steps 4-6 to add more locations.

"Module List Edito |

Pleaze define the modules to be included in the module list using the buttans
belon.

Modules

A0
&1

Add
Edit
Delete
tove Up
Mo Diovar

Load File

3

Finizh ‘ Cancel ‘

8. Click the Finish button to save the module list.



Importing a Module List

The Module List Editor is able to import a list of module locations from a .TXT file.
The file must use one of the following delimiters for the data: comma, space, or tab.
After each entry must be a carriage return.

If the file contains duplicate entries the duplicates will be ignored. For the locations
listed above, the following data formats would be acceptable:

Comma Delimited
A1,0,0

A2,800,0
A3,1600,0
B1,0,-150
B2,800,-150
B3,1600,-150
C1,0,-300
C2,800,-300
C3,1600,-300

Tab Delimited
Al<Tab>0<Tab>0
A2<Tab>800<Tab>0
A3<Tab>1600<Tab>0
B1<Tab>0<Tab>-150
B2<Tab>800<Tab>-150
B3<Tab>1600<Tab>-150
C1<Tab>0<Tab>-300
C2<Tab>800<Tab>-300
C3<Tab>1600<Tab>-300

Space Delimited
Al100

A28000

A3 16000
B10-150

B2 800 -150

B3 1600 -150
C10-300

C2 800 -300

C3 1600 -300



Chapter 7- Creating a Die Test

Introduction

The next step in creating a test plan is to build a die test script out of the module list
and module test scripts. The die test designates the order in which actions occur

during testing of a die.

Topics Covered

e Whatis adie?
e What a die test does
e Creating a die test sScript



What is a Die?

The definition of a die within Metrics ICV is the repeating unit on a wafer. All
stepping inside of this repeating unit is handled by the module list.

What a Die Test Does

A die test is the testing plan for the modules within the die. The die test directs the
probe station to step to a specific module and then run the selected module test at
that location.

Wafer Plan [Je Plan Module Plan

Start
—T

d i
rd
» Step Next Die | SE i DT ~" RunTests
/ [ Y—
I ' P ]
~ Call Module Script |, ©og
Call Diie Script '; Pl *h\ Switching
N Y \ Mo ,-f}"x I'I'. ¥
_ . ”' P iy " | Decision Making
i el | = Last Sub-Die? >
—._ LastDne? = \ - o
*-\.-\,_H.x\x ---d_f'-' \ =g Y -_____.d'
"‘"-\.-""--' " P
Yes Yes -

Creating a Die Test Script



The die script coordinates the sub-die stepping of the probe station with the
execution of module scripts. If testing is to be performed upon only a single module
per die, then the die test script will only contain a single stepping call.

To Create a Die Test

1. Open the Die Test Editor from the Development menu or click the Test
Script button in the Die area of the Metrics ICV navigation window.

rieseecon MM
(e < Metics b scipts » diescripts _______~ [ &5 ] oo

Organize « Mew folder H==

& Downloads it Mame Date modified

= Recent Places i _— = :
|| Demo Die Script.die 2/8/2012 9:54 &AM DIE File

|| ics_vtmos die 8/14/2012 2:58 AM DIE File

-l Libraries . ) o i .
|| icv_vtmos.die 7/13/2012 6:34 PM DIE File

3 Docurmnents
,J". Music
=] Pictures

B videos

18 Computer
ET;. Mew Volume (C:)
—a Local Disk (D)  + 4

File name: - [DIETEST (*.dig)

Open - Cancel
|

2. Type anew file name or open a die script file to edit.



Description: |Die AE321]

Add Line
Inzert Line
Dielete Line

Edit Line

Move Up
Morve Down
Capy

Paste

Camment

MHew Line

[ et

Globals

Froperties

| Save Ag | 0] | Cancel

3. Enter a Description and then click the Add Line button.



Description: |Die AE 321

7
Component Manager

a_ Script Flow
] Ewecute Module Script

Finish

Cancel |

Help |

Add Line

Inzert Line
Delete Line

Edit Line

fowe Up
Mave Dawn
Copy

Paste

Camment
Iew Line

Dizable

Edit Inputs |

Globals

4 L

| Debug | Fririt Save

| Save bz |

————————————

F

| Cancel |

Froperties

4. Select the Navigate Modules item and click the Finish button.



Description: |Die A4E 321

- Add Line
ol navigate_modules —_—

Ingert Line

Delete Line

Please select theModule Listand individual Modules to be Edit Line
navigated.
Move Up

Module List: Mave Dawn
icv-mos.mod

Copy

Paste

Caomrment
Iew Line

Dizable

Edit Inputs |

Finish Globalz

Froperties

r

| Save | Save As | Catcel |

5. Select the module list to use and highlight the specific module you want

to step to by selecting the first module and then using Shift-Click to
select the last module.
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Drezcription; |Die AFE 3

1) BEG Mavigate Modules [ icv-mos.mod - Multiple Modules | Add Line

Imzert Live

Delete Line

Edit Line

Move Up
e Do
Copy

Paste

Comment
Mewy Line

Dizable

i |

Globalz

Froperties

3

Save | Save bz | Ok, | Cancel |

6. The script will be updated to show the movement. Highlight the END
statement in the script and click the Insert Line button.



| Deszcription: |Die AE321

r
Component Manager

Add Line
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(3 Soript Flow Delete Line
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Paste
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r

| Save | Save fs | | Cancel |

7. Select the Execute Module Script item and click the Finish button.
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Select a file &J

Pleaze select the desired Script file to be Executed during test
execution,

Script File Marme:

Browse |

| Mext ‘ Cancel | Help |

8. Click the Browse button to open a dialog box to select the module test.

] File Selection S
AN | ;€ Metrics » scripts » modscripts - | 3 | Search modscripts 2 |
Organize « MNew folder =« i 'Zl:ﬂtl
4 Downloads *  Name Date modified Type

:.'J- Recent Places .
[ Deme Module Script 5/30/2012 8:28 AM  Screen sa
— (557 ics_vtmos 8/14/201210:12 AM  Screen sa
= Libraries = . i i
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j Documents =
] [ icw_vitmos 8/4/2012 2:32 PM Screen sa
,J‘i Music -
=/ Pictures
E Videos
18 Computer
‘;. Mew Volume [C)
(=] Local Disk (D::I - 4 T 3
File name: icv_vtmos A [Scripts. (*.scr) v]

| Open |v| | Concal |

9. Select the module script then click the Open button to select the module
test script.



10. Click the Next button to add the module script to the die test script.

BEG Mavigate Modules [ icv-mos.mad - Multiple Modules Add Line

Execute Module Script [ scripts‘modscriptshicy_vtmos. scr | Insert Line

Delete Line

Edit Line:

Move Up
Mowve Down

Copy

Paste

Cormment
Mew Line

Dizable

Edit Inputs |

Globals

Properties

11. Repeat the process for all additional modules you wish to test.



Chapter 8- Creating Wafer Maps

Introduction

At this point all of the methods have been defined and it is time to pick the die that
this testing will be performed upon.

This chapter details the how and what of probing in Metrics ICV. Features of the
Wafer Map Editor will be demonstrated. Several of the probe stations that Metrics
ICV supports have their own software, if necessary that software must be configured
to accept GPIB control. Metrics ICV does not support using wafer maps within the
probe station vendor’s software.

Topics Covered

e Creating a probe plan with the Wafer Map Editor
e Verifying the wafer pap



Creating a Probe Plan with the Wafer Map
Editor

Metrics Wafer Map Editor is the probing application designed by Metrics
Technology to control probe stations. This editor will take information regarding the
wafer and die size to produce a graphical representation of the wafer. The die
locations to be tested along with the reference die and coordinate system can also be
specified.

The steps to create a probe plan are:
1. Select Wafer Map Editor from the Probing menu or click on the

Map button under the Probe area of the Metrics ICV navigation
window.

Please select the desired Wafer Map file.

MMetriceWWaferMaps\Demo Wafer Map.map) Browse

Cancel ‘ Help ‘

2. Enter a name for the new map and click the Next button.

Note: All maps must be stored in the Metrics\Wafermaps directory.



Pleaze zpecify the wafer map dimenztionsz, flat location, and navigation options, and ‘w afer Center
adjuztements in the figlds below.

W afer Definition M avigation Optionz

Urits: L - Starting Location:
a

“Wafer Size: g -
+ Bi-Directional Movement

# Die Size: 15000.000 " Uri-Directional Movernent
¥ Die Size: 15000.000

* Maove by Bow
Flat Lacation: 270 deg - " Move By Colurnn

[ Don't Display \wafer Baorder

W afer Center Definition
* Auto Center
" Center On Die
" Center On ¥ and Y Streets
(" Center On ¥ Street, v Die
" Center On Street, ¥ Die

Fine Centering:

# Offzet [um]  |0.000
5 Offset [um]:  |0.000

Fres ‘ I et ‘ Cancel

3. Enter the wafer information. The Wafer Definition section is
required. The Navigation Options allow for the control of the
stepping direction of the probe station. Most users leave these as
default. The Wafer Center Definition allows the adjustment of the
wafer drawn by the Wafer Map Editor so that the map more
accurately reflects the actual wafer. (see the Technical Reference
Manual for further discussion of these features).

4. Click the Next button to continue.



Fleasze select the die locations to be vigited by using the left mouge button to click on the degired die
locations. To erase locations uge the right mouse button to click on the desired die locations.

Print

Select all =
5 Wer: &in
Un-Select Al 1 XSize: 15000.000um

¥ Sizz 15000.000um

Align Die: -3.1
Selactad:

Wizitzd: O

Cugrent:

XD
DX PRI
N XD Y

VAR CCCCCS
[ XXX X
NN

5. Click the Left mouse button to select the die locations that will be
tested. The Right mouse button can be used to un-select a location.
Click the Next button after selecting the tested die.



I Wafer Map Origin Definiti

Flease select the Origin die location using the mouse. I the ongin coordinates are different than 0.0
enter the Origing coordinates in the Origin Coords fieldz. Select Orientation optiong far the wafer map.

Prritt

Origin Coards L
s 5 War: fin
b X Size: 15000.000um
Y |0 T ¥ Size: 15000.000ua

Align Die: -3.2
Salectad: 49

Visited: O

Cuarent: 0.0

Orientation
[ Irwert 2
[ et

Chuck: CON
XDPos: 0.000um

Help

7 XXX X
1 I XX
\ XXXV
NG

Cancel

Pres

M est

6. Use the Left mouse button to select the location of the coordinate
system origin.

7. Click the Next button to continue.
Note: If you are using a fully automatic probe station, make sure

vour Die numbering EXACTLY matches the die numbering on the
probe station monitor.




-. De (| o=l S|

Flease select the Alignment die location uzing the mouse.

Print

Alignment Die L
% Wer: Gin
ol : X Size: 15000.000um
v |2 ¥ iz 15000.000u

Align Dis: 3.2
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7 XXX X
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8. Use the Left mouse button to select the Reference Die.

Note: The Reference Die is the location that the wafer is loaded to.
If this location is not specified correctly you will not step the wafer

correctly.

9. Click the Next button and the map will be saved.

10. An existing map can be edited by opening it with the Wafer map
Editor.



Verifying the Wafer Map

Testing the probe plan is a simple process in Metrics ICV. It is recommended that
any new map be tested to avoid long delays while a system collects data you did not
intend for it to collect.

Testing the wafer map can confirm:
1. The die size is correct.
2. The reference die location selected is correct.
3. The module list distances are correct.

The steps to verify a probe plan are:

1. Make sure you have already loaded the first wafer onto the chuck and
it is ready to go (aligned, at reference die, etc.).

2. Make sure your probe station has a defined contact and separation
height and they are not the same. Typically this is done by clicking a
Contact and Separate button on the probe station or the probe
station’s software.

3. Select the Control button under the Probe area on the Metrics ICV
navigation window.

4. Select the wafer map file to test and click the Open button.

"~ [ File Selection B
(e B < Metrics » WaferMaps <[ 43 [§ Search Worertiaps

Organize « MNew folder == -

4. Downloads - Mame Date Type
= Recent Places - - — :
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- Libraries
3 Documents
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=| Pictures

B videos

1% Computer
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cw Local Disk (D) - 4 1

File name: Demo Wafer Map.map - IWafer Maps (*.map)

l Open |vl I Cancel




5. The Interactive Wafer Map Navigation Window will open.

Note: During this time the map will try to communicate with the
probe station. If you receive an error, make sure the probe station is
ready to perform GPIB communication.

Interactive Wafer Map Na
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% Lett | e Right
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6. Select the Module List to be used from the pull-down list.

XK
XKD LK
XL LK

/XXX DK
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Wafer: 6in
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7. Click the Align Map button and verify that the wafer is over the
reference die. Use your microscope or video to check this. If using a
semi-automatic probe station, make sure the chuck is moved back to
contact.

e 3 Adjust probe so that it is over the ALIGNMENT position, the die location

8. Click the OK button when finished.

’ ! labeled with an "M, and place the chuck in the Contact position,

Cancel




9. The reference die will turn green indicating this is the current
location of the probe station.

[ Interactive Wafer Map Nav

Manual Wafer
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10. Either click the Play button to watch the station step through the
wafer plan (including module list locations) or double-click the Die
location you wish to move to. You can also double click the
Modules locations on the Module List control to move between the
sub-site locations.
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11. Click the Close button to end the verification testing.

Hint: Before closing the Interactive Wafer Map Navigation, move
the wafer back to the Reference Die and Reference Module.



Chapter 9- Run Test

Introduction

This Chapter demonstrates how to run a test. This section provides information on the daily
operation of the Metrics ICV system.

Topics Covered

e Getting a Test Started



Getting a Test Started

Test execution is started by clicking the Run button under the Execute area of the Metrics
ICV navigation window.

Development Probing Testing Analysis Tools Help  Exit

Device Algorithm Module i Execute

Connect

Device

= fRun

Wafer
Y

i N Test
VBScript
ptl___ & @ List L g Seript ————™ Map g Run

Y

Control

Al ~
Backup Restore Config System ﬂEIR'[E Plot Stats Analysis Help
KV e

N s teseation Sy

Before clicking Run button, one should verify that the following is complete:
1. A wafer map has been created.
2. A die test script has been created.
3. The wafer map has been verified.
4. The wafer (first wafer for fully automatic stations) is loaded, aligned, and at the
reference die upon the probe station.
5. All test hardware is turned on and connected via GPIB to the control PC.



To Run a Test:

1. Click the Run button on the Metrics ICV window.
2. The Test Execution Setup window will open. Enter the Process, Lot, Wafer,
Mask and Operator Information.

Note: These fields are optional but should be used to identify these

parameters for the test because they are written to the header in the output
data file.

Test Execution Setup

Process

Lot

W' afer

M azk

Operator |E

Euxecute Test: |sc:ripts\diescripts\icv_diude.die Browse
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[ Use Auto Probers az Semi-duto Probers

Thermal Configuration
[v Usze Thermal

Controller: | TEMF1

Temperature [C]: |33

Soak [s]: |EEI

Cancel ‘

3. Click the Browse button next to the Execute Test field.



Test Execution Setup
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]
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8/14/201210:59 AN DIE File

7/13/2012 6:34 PM DIE File

| Deme Die Script.die

— | ibrari || ics_vtmos .die
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[ Open |V] [ Cancel

4. Select the Die or Module script to be run.



Test Execution Setup
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5. Click the Browse button next to the Save Results in: field and select the data
file to be created.



est B

Test Execution Setup

Process

Lot

W afer

M azk

Operatar |e

Execute Test: |$Clipt$\diescriptS\M odd, die Browse

Save Resultsin:  |C:\Metrics\data'rmos-test-01. dat Browse

“Wwafer Testing Configuration

i ater Map: C:\Metricsw afernapsiDema W aker Map.map Erowse

[ Use Auto Probers as Semi-buto Probers [~ Put data from all wafers inta one file

Thermal Configuration

[~ Use Thermal

Contraller: |TEMF"| J
Temperature [C): |32

Soak [g]: |ED

Run ‘ Cancel ‘

6. Use the Browse button to select the Wafer Map to be run

Note: (if you are doing manual wafer probing select <No Wafer
processing>). If you are using a fully automatic probe station with only 1
wafer, select the Use Auto Probers as Semi-Auto Probers option to
prevent the station from unloading the test wafer.

Note: If you are auto-probing you can select the Put data from all wafers
into one file option to append all the wafer data to on results file. Otherwise
the suffix _Wafer(Slot#) will be appended to an individual file after each
wafer is complete.

7. Click the Run button to begin the test.



Rurtime Execution Status  Wafer Navigation Status

Wafer: Gin
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Current: 0.0
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8. If using a wafer map, the Metrics ICV software will prompt the operator to
verify the Reference position. Click OK to confirm the reference position.



Runtime Execution Status I Wafer Navigation Status ]
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: 13:15:16
PROGRESS Iafer

Manual Wafer
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9. The Runtime Status Window will open, click the Start button.
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10. While the test is running, the Wafer Navigation Status Window will show

the current die that is being tested.




Runtime Execution Status | Wafer Navigation Status |

IVIETEiEE st Testing Complete..

‘ , Test Started: 12/30/1899 000000
Icv w.c-vo:mw Lttty

08/14/2012 13:20:05
Test Duration:
TESTIN

41135 13:20-11
PROGRESS

11. At the end of the test the Runtime Status Window will provide a Test
Complete status message.

12. Click the Close button to end the current test




Chapter 10- Data Manipulation

Introduction

This chapter covers the data that was collected in the previous chapter and what can be done
to it using tools built into Metrics ICV.

Topics Covered

Where is the cata?
Creating a wafer map
Exporting data
Viewing data curves



Where is the Data?

The data created by the execution of the Metrics ICV software is saved in the file specified
by the operator when starting the test.

Test Execution Setup

Process

Lot

W' ater

M azk,

Operator |E

Execute Test: |$cripts\diescripts'\M odd, die Browse

Save Results in: |E:‘\Metrics\data\nmus-text-m .dat Browse

Whater Testing Configuration

"W afer Map: C: A etricsshw afemapziDemo ‘' afer Map.map Browze

[ Usze Auto Probers az Semi-buto Probers [~ Put data from all wafers inta one file

Thermal Configuration
[ Use Thermal

Contraller: | TERP1 J

Temperature [C): |32

Soak [z): |EEI

The data is saved in tab-delimited ASCII format.

In addition the file contains tags to identify the various levels of data. This representation is
reasonable to read, but is very desirable for writing post-processing macros.
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Creating a Wafer Map

Metrics ICV contains a tool named the Metrics Miner. The Metrics Miner application is
very useful for the viewing of Wafer Maps and manipulation of data.
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This first example will detail how to create a wafer map using Metrics Miner.

The steps to create a probe plan are:

A. Start Metrics Miner

The Metrics Miner can be started from the Metrics ICV toolbar by clicking the
Analysis >> Miner menu item or the Stats button under the Analysis area of the
Metrics ICV navigation window.
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B. Load Data

The first step to manipulating the data with Metrics Miner is to load the data from
the saved data file.
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Click the File | Load Data menu item.
Select the directory containing the data file.
Select the data file.

Click the Open button.

1.
2.
3.
4.

C. Select Parameter to Map

Once the data has been loaded, subsequent wafer maps or data exports can be
created without reloading the data.
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I. Click the View | Wafer Map menu item.
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List Parameter Selection E3 |

Please select the data groups to be ncluded in the View. Available
data groups are based upon pnor data group selechions.

Data Groups at Level 0

D |,. { . |

8] I [6.8]

SelectAl | Unselect Al |

Hint | Cancel | -_'e.v._'..;:i ﬂev&{ Fintsh |

2

I1. Select the die locations to map:

1. Select the Die locations
2. Click the Next button.



List Parameter Selection

Please select the data groups to be included in the Yiew. Available
data groups are based upon pnior data group selechions.

Data Groups at Level 1
[scnpts\H=TDATH /B dis|

Select Al | Un-select Al |

Hint | Cancel | Ermriuusl Mest

B3|

I11. Select the die script that contains the parameter to map:

1. Select the Die script
2. Click the Next button.




List Parameter Selection E3 |

Please select the data groups to be included in the View. Available
data groups are based upon pnor data group selechons.

Data Groups at Level 2

M odule (D% [800,-450])
Module [DE [1000.-450)
Madule (A1 [0.0]]

Moduls (A2 [200,0]]

[

Select All Un-zelect All

Hint Cancel Previous Next Firesh

IV. Select the module that contains the parameter to map:

1. Select the Module
2. Click the Next button.



List Parameter Selection E3 |

Please select the data groups to be included in the View. Available
data groups are based upon pnor data group selections.

Data Groups at Level 3
SCRIFT [sonpts\HS TDVATT 2o

Select Al | Un-select Al |

Hint | Cancel | Erevii:uusl MNext Finish

[t

V. Select the module script that contains the parameter to map:

1. Select the Module script
2. Click the Next button.



[

List Parameter Selection El |

Pleazs salact the data groups to be included in the View, Available
data groups are based upon pnor data group selechons.

Data Groups at Level 4

Dewice [DE]
Dewvice [DC)
Deswce (DD
Dewice [DE)
Dewice [DF)
Dewce [DG)
Dewvice [DH)
Dewce (D)
Dewice [DR)

Select Al | Un-select All |

Hint | Cancel | Erevimz' ﬂe:-:t:é Firesh I

N

2

VI. Select the device whose parameter is to be mapped:

1. Select the Device
2. Click the Next button.



List Parameter Selection E3 |

Please select the data groups to be included in the View. Available
data groups are based upon pnor data group selechons.

Data Groups at Level 5

Algonthr [GRNDFET42)
Algonthm [FET_OFF42)
Algonthen [FET_OM42)
Algonthm [VTXBETA42)
Algonthm [I5UEMAX4Z)
Algonthm [VTLINA142)

SelectAl | Un-select All |

7

Hint | LCancel | Ereviuusi MNext

I

VII. Select the test algorithm that contains the parameter to map:

1. Select the test Algorithm
2. Click the Next button.



(L

List Parameter Selection

Please select the data parameters to be included in the View.
Availlable data parameters are bazed upon prior data group
selections.

Data Parameters

VD-VALUE[c]
WViaValLUE[c]
VSNMALUE|c]
WBAALUE[:]
VG

|3

Celect A | uh-sehl:tﬁlll

B

Hint | Cancel | Erevinusi ﬂe:-:t{ Firssh

T

VII1I. Select the parameter to map:

1. Select the Parameter
2. Click the Next button.



b3

D. Setup Map Title and Notes

The wafer map can be given a Title and Notes.

View Documentation | X |

Please enter a Title and Motes to be displayed on the Yiew,

|

g=36V

Hit | Cancel | Previous |

1. Enter a Title for the wafer map.
2. Enter Notes for the wafer map.
3. Click the Next button.




E. Setup Bins

The binning must be set for the wafer map. The values can be binned automatically
or the user can specify upper and lower bounds along with the number of bins.

Bin Information Setup El

Plaass entes b jangs parameters, the numbe of bing bo wee,
and customze the atsociated bin colos.

MiiounBinVabe [EREEEMEE
awamun Bin Value: |-21??322?? Busto Bin |

Brua; Bin Color

Bin 3 -2 13066 «="aL « -2 18621

Bind -218627 <=WAL < 218177

BinS -218177 «=VaL < 217732
2

Ht | Concel | Previous |  hes Firish

1. Enter the Bin parameters.
2. Edit the bin Colors.
3. Click the Next button.



F. Results

The resulting wafer pap is shown below. This plan can be copied to the clipboard
and pasted into other programs. In addition the plan can be printed directly to a

printer.

= Wafer Map

Bia 1 0715025 <= WAL < DT 16156
B =2 07018038 0= VAL £ DT16243
B B3 0708043 == WAL < 0716351

Bzt 07108315 WAL = DT 10458

. EBin 5 0 716455 <= WAL < 0 716555

Statstics

oo 071603
Dwdnemy: 0716554
D 0714103
Sigpa: 000010TE4T

Smpkc: 60

Iletncs Bhner
Toats: DEM2AT
Time: 13 015:44
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Exporting Data

The Metrics Miner application is very useful for the viewing of wafer maps and
manipulation of data.

A B C T
1| process(s] Mew Deposian I |
2 |laffs] 165
3 |wabar(s] 12
4 Imask[s]
il:fll:llﬂlultj kmg I:I

B |Danz(s] 9M19/9%

¢ | Tima[z] 16:00:55

g

9| Tiie Dievice D& Parametars

L1

1 = Y IDOFF 100w BETA, WTH ISLIBMA WTLIK

12

13 ] 4 Modula (41 (0.0)) Devaca (D) -BSE-11 0n0GR4 00568 0758502 2 TSE-10) 0410203

14 | b = Mool (A1 (0L0])) Dessce [La) cbsE-10 Qe COSE DRETSIS & I4E-100 O 4UY56:
15| 4 £ Module (A1 (0.0)) Deesca (Dv) SMEAD 109 00578657 OGEE498  329E-10 Q409684

16 | Z 2 Moduba [A1 {00} Dessca (Da) Z0ZE-10 01464 00592667 OGE3015 Z74E-10 0409633
1 b 2 Modubs [A1{0.0)) Dessca (D) LFSESID DMNMIE DOS79EEF  OESOPE J.ZBE-10 0.40955% B
W4 b W testd 14] [ e

This example will detail how to export data parameters using Metrics Miner

The steps to export data are:

A. Start Metrics Miner

The Metrics Miner can be started from Analysis >> Miner menu item or the Stats
button in the Analysis area of the Metrics ICV navigation window.



Development Probing Testing Analysis Tools Help Exit

Device Algorithm Module i Execute

Connect

Device

Run

-

VBScript

Y

Control

Backup Restore Config Systermn ﬂEIRi[E Stats Analysis

S T ——

B. Load Data

The first step to manipulating the data with Metrics Miner is to load the data from
the saved data file.



Look jrt

g e den

|':_1|:|a|a

| Copyof loren.dat B bekresuts dat
Evport Earameters 3] ke dat (2] bevat st
Export 41 Data 3] phedaa dal 3] th7bal 42iesulls dat
3] precata? dat 3] thTbeesuks dat
3| precataddal
3] owilch.dat
1
Filepame:  [th7od14 2zl dal A
Files of fvpe: | Dt Files [ cot) = Cancel| |
™ Open &z mad-ony :
]
3

Click the File | Load Data menu item.
Select the directory containing the data file.
Select the data file.

Click the Open button.

1.
2.
3.
4.
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C. Select Parameter(s) to Export

Once the data has been loaded, subsequent wafer maps or data exports can be
created without reloading the data.

h M Im % I'-'Iaru|

I. Click the File | Export Parameters menu item.
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Data Documentation E3 |

Please enter a Title and Notes to be Exported with the Data

Hint | Cancel | ErEviols

Il. Give the File a Title and Notes:

1. Enter atitle for the exported data.
2. Enter notes for the exported data.
3. Click the Next button.



List Parameter Selection E3d |

Please select the data groups to be ncluded in the View, Available
data groups are based upon pnor data group setections.

Select Al | Un-select Al |

Hint | Cancel | '_'?-"."n.'.--i-i' ﬂev&{ Firesh |

2

I11. Select the Die locations to be exported:

1. Select the Die locations.
2. Click the Next button.



[

List Parameter Selection

Please select the data groups to be included in the View, Available
data groups are based upon prior data group selechons.

Data Groups at Level 1
[senptz\HS TDATH /B, disl

Select Al | Un-select Al |

Hint | Cancel | Ereﬁuusl Mext

|

IV. Select the Die script that contains the parameter(s) to export:

1. Select the Die Script
2. Click the Next button.




=

List Parameter Selection E3 |

Flease select the data groups to be ncluded in the View. Available
data groups are based upon pnor data group selechons.

Data Groups at Level 2

M odule [[35 [800,-450)]
|"-"||:u:|u|E 6 (1000 -450))
Module (47 10.0]

b odule [&2 [200.0)

SelectAl | Un-select Al |

Hint | Cancel | E‘reviuus! Mext

V. Select the Module that contains the parameter(s) to export:

1. Select the Module
2. Click the Next button.



[

List Parameter Selection

Please select the data groups to be inchluded in the View. Available
data groups are based upon pnor data group selections.

Data Groups at Level 3
SCRIFT [sonpte\HSTDAATT 2o

Select Al | Un-select Al |

Hint | Cancel | Erevii:uusl Mest Finish

]|

[

VI. Select the Module Script that contains the parameter(s) to export:

1. Select the Module Script
2. Click the Next button.



(Lo

Lizt Parameter Selection E3 |

Plaase salact the data groups to be included in the View. Available
data groups are based upon pnor data group selechons.

Data Groups at Level 4

Dewce [DE]
Dewvice [DC)
Deswce [DD]
Cewice [DE)
Dewice [DF)
Dewice [DG)
Dewvice ([DH)
Dewice (DO
Dewice [DR)

Select Al | Un-select Al |

Hint | LCancel | Erevims' Mext

Finizh I

[

VII. Select the device whose parameter(s) is to be exported:

1. Select the Device
2. Click the Next button.



[

List Parameter Selection |

Plzaze select the data groups to be ncluded in the View. Available
data groups are based upon pnor data group selections.

Data Groups at Level &

Algarithm [FET_OFF42)
Algonthm [FET _OMN42)

Algorithm [WTHBET,
Algonithrm 1S LBMA
s otk W

Select Al | Un-select Al |

Hint | Cancel | Erevims' Next

VII1I. Select the Test algorithm(s) that contains the parameter(s) to export:

1. Select the test Algorithm. You can select more than one.
2. Click the Next button.



List Parameter Selection |

Please select the data parameters to be included in the Yiew.
Avalable data parameters are based upon prior data group
selections.

Data Parameters
VD -

IOFF

IOMN
YGE-PTS[e)
/‘M’G-ST&HT[-:]
YG-STOPc]
YG-STEPc]
13 VG-COMPLc

|SLIBM AR

Selectdl | Un-select Al |

Hint | LCancel | Erevimai = | Firesh Ll\
2

IX. Select the parameter(s) to export:

1. Select the Parameter. You can select more than one.
2. Click the Next button.



L

Savein | dala

=] ®) ¥ e

Tﬂ pi izt

8] test! b

Fie name  |iest et

Save az byps: |L;|-nl-:| Filez [* dat)

™ Open as prad-only

X. Select the file to save the parameters in:

1. Select the file directory.
2. Enter a file name.
3. Click the Save button.




Viewing Data

Metrics ICV contains a tool named the Metrics Data Browser. The Data Browser
application is very useful for the viewing of the data. The data can be represented in table or
plot form. After defining a plot, it is easy to select other locations and view the data.

. Matncs Data Browser

Costy File: ||'_'---E'H C5h e’ 234 el
28 duigrsinan devckg e 73, [§FaD
i | Pt pas | Das |
Vi Plot
o .
Marpon: 2
Harpoy 1
|:| I: | | L ] lhl:h!. 4
¥
4
L=
]
¥
o
i; | Cirmny
0o I" :
Crazilp 1
] | Dhvarkay 2
Chamrda 0
1 13 —_
on 1.3 o4 1] DB i0 el 4
W
i 2
Cusio 3
o il

Brorarm I Fia-Somn Dt I

Dada Ky Salaction

[i =] [n k]

T [ zoocterean desvstonrc ] £ 3 |

Filgusttes [reFwm e
Lipd s Wwar Fal E

This example will demonstrate how to view Data Plots using the Metrics Data Browser.

The steps to view the data are:

A. Start Metrics Data Browser

The Metrics Data Browser can be started from the Analysis >> Data Browser
menu item or the Plot button in the Analysis area of the Metrics ICV navigation

window.



Development Probing Testing Analysis Tools Help  Exit

Device Algorithm Module i Execute

Connect

Device
\J

Test
7 Script

A

VESCript

|

Control

Backup Restore Config System ﬂETRi[E Stats Analysis

KW 00 £ s et Syt

B. Load Data

The first step to viewing the data with Metrics Data Browser is to load the data from
the saved data file.



Click the Browse button.

Select the directory containing the data file.
Select the data file.

Click the Open button.

el NS

C. Setup the Plot

Once the data has been loaded it is ready to be plotted.
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I. Open the Plot Setup window.

1. Click the Plot Setup button.
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Dicde Famward 1V
b

L

Il. Provide a Plot title.

1. Highlight the Title window and enter a title for the plot.
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w. Plot Setup

Pled Title: |Diode Forwad 1
V¥ Auto Scake Plot
—A Selup
Title: |wionward
ym
b o
]_.//' b i o Uity |
[ LogScale
" Setup
Title: |
T Data Wiy
L&
b j—
i J"""-—""'—' o froe
[ LogScale

Ok

[11. Setup the X-axis:

1. Enter atitle for the x-axis.
2. Select the data vector for the x-axis.




w. Plot Setup

Fiot Tile: |Diode Forsard |-
¥ Buto Scale Flot

i = Sehup
Tile: [\iaisaid
e >

| ]— (RLE| I

[T LogScale
L Satup
| Thle [ifcrwand |
7 |
| | -

P 1— 1 I- I

IV. Setup the Y-axis:

1. Enter atitle for the y-axis.
2. Select the data vector(s) for the y-axis.
3. Click the OK button to close the Plot setup window.



D. Review Data

|. Select other die locations to view.

Diode Forward |-\

1. Left or Right buttons next to the die location to change sites.
2. The plot is automatically updated.
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Chapter 11- System Backup and Restore

Introduction

A new feature of Metrics ICV is the ability to backup and restore the system using built-in
functions. This feature is very useful for the rapid backup of a system into a single archive
file.

Topics Covered

e How to backup
e Special requirements
e How to restore



How to Backup

The backup feature is designed to be very simple to use. The process is a simple three steps.

Development Probing Testing Analysis Tools Help Exit

Device Algorithm Module i Execute

Connect

Device

Run

-

Wafer
A ]

; ) Test
VBScript | List 1]
— B A — — B
P is Seript ap Run

Yy

Control

Al ~
Backup Restore Config System ﬂEIRl[E Stats Analysis Help
KV g

W et Syt

Create a Backup:

1. Select Backup from the Tools menu or the Backup button in the System
area of the Metrics ICV navigation window.

Select the file name and location for the backup.

Click the Open button.

4. The Metrics ICV components will be compressed and stored.

wmn



Special Requirements

The backup feature is designed to be very simple to use. In order to make the feature as
easy to use as possible, the default directories for saving components are backed up. The
backup feature does not search for files saved in other locations.

Backup Directories

Metrics\data
Metrics\algs
Metrics\ics\projects
Metrics\reports
Metrics\scripts
Metrics\Wafermaps



How to Restore

The restore feature is designed to be very simple to use. The process is a simple two steps.
The restore feature is designed to be used on a complete installation of Metrics ICV.

Development Probing Testing Analysis Tools Help  Exit

Device Algorithm Module Execute

Connect

Device

Run

-

Wafer
Y

i N Test
VBScript
ptl___ & @ List L g Seript ————™ Map g Run

Y

Control

Al ~
Backup Restore Config System ﬂEIR'[E Plot Stats Analysis Help
KV e

N s teseation Sy

To Restore:

1. Remove the Metrics ICV software by using the Add/Remove feature of
Windows (Control Panel)- remove all Metrics components.

Delete the Metrics directory.

Re-install the Metrics ICV software from CD.

Install the most current HotFix.

Select Restore from the Tools menu or the Restore button in the System
area of the Metrics ICV navigation window.

The Metrics ICV components will be un-compressed and restored.
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